FmPro Migrator Developer Edition - Table Consolidation Procedure
10  Finishing Up

10.1 Manual Completion Tasks 83
10.2 Troubleshooting AppleScript GUI Automation [macOS] 85
10.3 Troubleshooting WinAutomation GUI Automation [Windows] 91
10.4 About the FmPro Migrator WinAutomation Tester [Windows] 97
Installation
Installation Tips

This document provides an explanation of the steps required to import info from FileMaker Pro database files using FmPro Migrator Developer Edition and FileMaker Pro Advanced.

FmPro Migrator 8.34
Revision 21
9/12/2017

Changes with this version:
Added info & screenshots showing copy & paste of Custom Functions with FileMaker Pro Advanced 15+ versions, updated notes to recommend using setting OS to use English, replaced ScriptMaker Scripts with FileMaker Scripts in the text, replaced ScriptMaker window with Script Workspace window in text, updated screenshot for import scripts dialog.

FileMaker 14+ Notes - Copy Layouts to FileMaker - Windows

On Windows, it may be necessary to manually click on the Yes button the first time the Extend Objects Dialog is displayed. Otherwise, the button won't get clicked and an error will be displayed. After manually clicking on this dialog once, it will be automatically clicked every other time it is displayed.

Note: This issue appears to be intermittent and may no longer be an issue.
With FileMaker 14+ on Windows, it is not possible to get or set the contents of the TO name combobox menus on the Edit Relationship dialog. In fact, even a user cannot use type-ahead to set the contents of these menus - this is a change in behavior compared to FileMaker 13. Therefore, it will probably be necessary to revert back to FileMaker 13 on Windows or use FileMaker 14+ on macOS to build relationships.

AppleScript is not able to click the 1st script in the list of scripts in the Script Workspace window. FmPro Migrator will prompt you to manually click the first script before processing can start. Once this has been done, the rest of the processing runs normally.

**Note:** This dialog may not always display right away. It may require clicking on the Script Workspace before it is displayed.
Some DDR Files exported from FileMaker Pro Advanced 14 might be corrupted when created by FileMaker. This can be an indication of corruption within the FileMaker database. However some of these DDR XML errors may disappear by using FileMaker Pro Advanced 13 to export the DDR XML file.

**WorkAround:** You can ALWAYS export a FileMaker 13 DDR XML file and use this file for a FileMaker 14 Table Consolidation project. There is nothing extra included in a FileMaker 14 DDR XML file which FmPro Migrator requires in order to complete the project. Furthermore, FmPro Migrator doesn't check the version info written into the DDR XML file, only the version of the running FileMaker Pro Advanced application. FmPro Migrator captures the objects most likely to change between FileMaker versions (scripts, layouts) via the clipboard.

If you cannot import the DDR XML file into BaseElements or Inspector Pro, then FmPro Migrator won't be able to read it either.

For more details, please see this web page at [Goya.com.au about DDR XML file corruption](http://example.com).

**Installation & Pre-Migration Tips**

**Tip1:** Configure your operating system (macOS or Windows) for English language. Even though the AppleScript scripts on macOS are intended to work with other languages, there can still be some compatibility issues when using any language other than English.

**Tip2:** Don't rename the FmPro Migrator or FileMaker Advanced executable files on your hard disk. If you want to maintain different versions of these applications, put them into folders containing different names. The AppleScript/WinAutomation scripts look for these two applications by their executable filenames, and if they are renamed the shortcuts won't be able to find the applications even if the applications are currently running.
Tip 3: On macOS make sure that you only have one copy of FileMaker Pro Advanced running and only one database open when performing the GUI automation tasks (importing layouts into FmPro Migrator, creating value lists, custom functions, scripts, layouts in FileMaker Pro Advanced). FmPro Migrator will verify that the version of FileMaker you have selected in the Source Database and Destination Database menus matches what is currently running. But if 2 copies of FileMaker are running, this verification process will not necessarily work properly. It is likely that the first opened copy of the FileMaker application will receive the AppleScript commands.

Tip 4: On Windows, in order for the compiled WinAutomation job to find menu items within the FileMaker user interface, the database window should not be maximized. Click the Restore Down button in the window if it is maximized. The source code for the job file is written into the C\<username>\My Documents\WinAutomation_Jobs folder as a file named _FmPro Migrator WA Jobs.waj. This file is available under open source licensing, and modifications can be made by the user if necessary, for instance for updating the job file to work with localized versions of FileMaker.

Tip 5: Duplicate value lists and script names need to be considered prior to performing a Table Consolidation or Conversion project. If duplicated value lists and custom functions contain the same functionality, you don’t have to do anything because FmPro Migrator will skip them automatically. Otherwise, these duplicated objects should be renamed within FileMaker prior to starting the Table Consolidation project.

Select Output Directory

FmPro Migrator stores migration information for each project within a SQLite database file named MigrationProcess.db3. FmPro Migrator needs to know where this file should be stored, prior to starting your migration project. You can have as many MigrationProcess.db3 files as needed (for
instance a separate file for each project), as long as these files are stored within different directories on your hard disk. This output directory is also used for writing automation scripts, instructions and the FileMakerDB.fp7/FileMakerDB.fmp12 template database file.

On the FileMaker tab within FmPro Migrator, click the Browse button, then select an output directory.

[If you select an output directory which already contains a MigrationProcess.db3 file, the yellow Continue... button will be enabled so that you can continue working on a previously created project. Otherwise, the MigrationProcess.db3 file will be created automatically when you add the first table to your migration project.]
Selecting both the Source Database and Destination Database types as FileMaker 7/8/9/10/11/12/13 triggers FmPro Migrator to enter Table Consolidation mode once the first table is copied from the Clipboard.

Note: It is important to accurately select the type of Destination Database in order for FmPro Migrator to use the correct AppleScript or WinAutomation scripts when performing migration tasks. Different versions of FileMaker have used differing menu options, therefore customized automation scripts are used by FmPro Migrator based upon the database version.

On macOS and Windows, FmPro Migrator will attempt to determine if you are running a version of FileMaker Pro Advanced which is different from what you have selected for the Source/Destination database types. It will also check to see if you are running 2 copies of FileMaker Pro Advanced at the same time, and will warn you to close one of them.

**FileMaker 12+ Note1**: As of FileMaker 12, there have been changes made to the format of XML code placed onto the clipboard for layouts and scripts. These different formats are not fully compatible with different versions of the FileMaker database. For instance, if you capture layouts with FileMaker 11 and then try to paste them into FileMaker 13, the contents of the layout won't get pasted. So for Table Consolidation projects it is recommended that you use the same version of FileMaker for all phases of the project. Therefore, select the source and destination database versions to be the same version.
**Convert FileMaker 5/6 Files**

When upgrading FileMaker 5/6 files, the files should be converted into .fp7 files using the FileMaker Pro 11 Trial Version from the FileMaker website. This tech note provides further details: [http://help.filemaker.com/app/answers/detail/a_id/10571](http://help.filemaker.com/app/answers/detail/a_id/10571)

FmPro Migrator Developer Edition uses FileMaker Advanced 11-13 when performing a Table Consolidation or Conversion project. Open the original (older) files with the newer version of FileMaker Advanced and the files will be converted automatically by FileMaker. For the purposes of this documentation, these new files are considered to be the source data files for the project.

For example, if you want to convert FileMaker Pro 5.5 (.fp5) files to FileMaker Pro 13:
1) Download the FileMaker Pro 11 Trial version from the tech note provided above.
2) Convert the .fp5 files into .fp7 files using the FileMaker Pro 11 Trial version.

Within FmPro Migrator, you must select FileMaker 13 as both the source and destination database versions.

**Install WinAutomation jobs [Windows]**

This step does not need to be performed manually anymore. The first time you use any of the GUI automation tasks on Windows, the _FmPro Migrator WA Jobs.exe file will be exported into a new folder: C:\My Documents\WinAutomation_Jobs and will be launched automatically.

On macOS, the AppleScript code is embedded within FmPro Migrator therefore no installation is required.

Selecting this menu will save a text file of AppleScript code, a LiveCode AppleScript test stack and a LiveCode performance testing stack to the output directory.

These files have been released as open source for use by the FileMaker community.
FmPro Migrator requires information from the FileMaker Database Design Report (also known as DDR XML) in order to import information about FileMaker Pro TOs, Relationships, Value Lists, Custom Functions and Layouts.
For each FileMaker database file to be migrated, select Tools -> Database Design Report...
When prompted for the output directory, select XML as the output file type (do not select HTML).

DDR XML files can be exported for all open FileMaker database files as the same time.

**Note:** DDR XML files can only be exported by FileMaker Pro Advanced, not FileMaker Pro.
Step 1
Step 1 - Import Table Definitions (TC)

**Step 1 - Import Table Definitions**

FmPro Migrator Developer Edition uses FileMaker table definitions copied from the clipboard for table consolidation and conversion projects. These table definitions include all table/field options, validations and calculation formulas required to recreate the tables within a new database file. When performing SQL database conversions, this info is also used to create new tables in the SQL database.

**Step 1 - Open Define/Manage Database Dialog within FileMaker**

Open each source database file within FileMaker Advanced. Select the table within the Define/Manage Database dialog, click the Copy button.

Open each source database file within FileMaker Advanced. Select the table within the Define/Manage Database dialog, click the Copy button.
On the FileMaker tab of the main FmPro Migrator window, select the "Clipboard XML" menu item, then click the Get Info button.

**Export DDR File**

After copying the table definition via the Clipboard, export a DDR XML file from each source database file. These files will be used to import Relationships into FmPro Migrator later in the migration process.
Once the first table has been copied into FmPro Migrator, the yellow Continue... button will become visible. Click the Continue... button to open the Migration Process window.
Clicking the Continue... button opens the Migration Process window to the Tables tab. The Table Consolidation text in the upper left corner of the window provides a visual indication that FmPro Migrator is in Table Consolidation mode.

The overview of the Table Consolidation process includes:
[Step 2] capturing Layouts,
[Step 3] copying ScriptMaker Scripts,
[Step 4] importing Relationships and Table Occurrences from Database Design Report (DDR XML) files created for each of the source database files,
[Step 5] Object remapping and layout text search & replace tasks,
[Step 6] creation of Tables, Table Occurrences and Relationships, in the new consolidated file,
[Step 7] creation of Scripts and Layouts,
[Step 8] creation and use of data import scripts to import data from the source database files to the new consolidated file.
Step 2
Clicking the Step 2 - Get Layouts button opens the Layouts tab of the Migration Process window.

You can also click on any of the folder tabs across the top of the Migration Process window to go directly to that area of functionality.
Step 2 - Layouts Tab

The Layouts tab provides an interface for managing layouts during a migration project. Layouts can be captured from FileMaker either one at a time [1] or in batch mode [2], and can be transferred to FileMaker the same way [3],[4]. Search & Replace parameters [5] for layout text can also be specified.

Clicking on a layout in the list displays details for the layout, including a thumbnail version of the layout image.

Clicking on a portal displays the portal rectangle on the thumbnail image. The portal details, including Portal Fill, SQL and Portal Titles fields are not used during Table Consolidation migrations.
Step 2 - Layouts Tab - Entering Layout Search & Replace Parameters

Clicking the Layout Search & Replace button displays the dialog for specifying these parameters. Any number of Search Text and Replace Text values can be specified in this dialog.

Enter each value, then press the TAB key or Return key to advance to the next cell or row.
Click the Batch Import All Layouts button on the layouts table of the Migration Process window. This import method uses AppleScript/WinAutomation to control the FileMaker Pro graphic interface and import each layout using the clipboard.
### Layouts Within Nested Folders

Some layouts within nested folders might not get imported during the automated importing process. It is recommended that layouts be moved to the top level of the folder structure to prevent this issue.

### Mission Control - Shortcut Key Conflict with Command Up Arrow in FileMaker

On macOS, one of the default shortcut keys for Mission Control conflicts with the FileMaker Shift Down Arrow shortcut used for advancing to the next layout. FmPro Migrator will import the same layout many times if this conflict exists. Before importing layouts, disable this conflicting shortcut key.
in the System Preferences -> Keyboard panel for Mission Control. It is a good idea to disable 3rd party automation tools which might also have conflicting shortcut keys.

**Step 2 - Click Import All Layouts Button**

The Import All Layouts button starts the process of importing all of the layouts.

**Note:** The Import Type menu is covered up by the TO Name menu when a layout has been selected in the list - as shown in this screenshot. Also shown in this screenshot is the location of Portal1 on the thumbnail image of the layout, since Portal1 has been selected from the list of portals.
Step 2 - macOS 10.9 Security Dialog

On macOS, FmPro Migrator uses AppleScript to perform batch processing tasks with FileMaker database files. Starting with macOS 10.9 (Mavericks), each application which uses the Accessibility API to control the computer needs to be authorized. FmPro Migrator performs a test to verify that it has been authorized to control the computer via AppleScript GUI scripting, and presents this dialog if it has not yet been enabled.
Step 2 - macOS 10.9 Security Preferences

In the macOS System Preferences, click the Security & Privacy icon, (1) click the Accessibility item in the list, (2) click the lock button to allow changes, (3) click the checkmark next to the FmPro Migrator application.

Note: You will need to perform this unlocking process once, for each new version of FmPro Migrator is installed on your computer.

After allowing Accessibility access for FmPro Migrator, it will often be possible to immediately click on the same GUI batch processing button in FmPro Migrator to proceed with the migration. Sometimes you need to re-launch FmPro Migrator after making this change, and it can be helpful to close the System Preferences window to insure that macOS has recognized the change.
Step 2 - Select the DDR XML File

(1) Select a DDR XML file, (2) click the Open button.

**Note:** FmPro Migrator Developer Edition requires a Database Design Report as a DDR XML file created with FileMaker Developer/Advanced 7+. This DDR XML file is used by FmPro Migrator to count the number of layouts which will be copied via the clipboard, as well as the order in which the layouts are found within the FileMaker database file. The DDR XML file should be re-created if any layouts have been deleted or moved within the file by using the Manage Layouts dialog.

This DDR XML file needs to be created with the same version of FileMaker Pro Advanced which is being used for the table consolidation project. The version of FileMaker Pro Advanced should remain the same during the entire table consolidation project and this version should be selected as both the source and destination database versions on the FileMaker tab of FmPro Migrator.

FmPro Migrator will loop thru all of the layouts and capture them via the clipboard by using AppleScript or WinAutomation to drive the FileMaker graphical interface.

Step 2 - Troubleshooting - Mis-Matched FileMaker Versions Error [macOS]

FmPro Migrator needs to have an accurate idea of which version of FileMaker Pro Advanced is currently running on your computer in order to use the correct AppleScript code to perform each task. This means that it is important to select the correct Source Database and Destination...
Database on the main FmPro Migrator window.

If you are capturing layouts from FileMaker Pro Advanced, FmPro Migrator will verify that the source database version you selected is the actual version which is running on your computer [see dialog above].

If you are building objects in FileMaker Pro Advanced (i.e. value lists, custom functions, scripts, layouts), then FmPro Migrator will verify that the destination database version you selected is the actual version which is running on your computer.

---

**Step 2 - Troubleshooting - Locks Up with No Processing Completed [macOS]**

If a batch processing task starts, but appears to lock up with no activity, then force quit and re-launch FmPro Migrator from the Finder and open the Status Window by selecting the File -> Status Window menu item. Click the batch processing button again, and review the results in the Status Window.

FmPro Migrator will continue to log the results of its AppleScript processing handlers in the Status Window as long as the window is open.

As shown above, the ASwitchFMToLayoutMode handler has run, but nothing else has completed. This type of problem can be due to having 2 copies of FileMaker Pro Advanced open at the same time. Some of the commands might get sent to one copy of FileMaker and other commands could get sent to the 2nd copy of FileMaker.

If a single copy of FileMaker Pro Advanced is running, but the FileMakerDB.fp7/FileMakerDB.fmp12 file is not open, a similar problem might also occur.

For more details about the tasks performed by the AppleScript handlers, please see the Troubleshooting Info at the end of this document.
On Windows, the GUI automation is implemented using a compiled WinAutomation job file. During the execution of the WinAutomation job file, a notification window is displayed showing the status of the functions and individual actions as they are being executed.
Step 3
Click the Step 3 button to copy all of the FileMaker scripts from each FileMaker source database.
Step 3 - Scripts Tab

The Scripts tab provides an interface for managing FileMaker Scripts during a migration project. Scripts can be captured [1] from FileMaker by copying them to the Clipboard within the Script Workspace window of FileMaker Advanced. Once the scripts have been updated by FmPro Migrator, they can then be copied to the Clipboard [2] and pasted back into FileMaker Advanced. There can sometimes be problems pasting scripts into FileMaker, therefore the [3] Create All Scripts in FileMaker batch processing button can create all of the scripts in batch processing mode (macOS only).

Scripts can also be viewed within FmPro Migrator by clicking each script and viewing the text version of the script within the Script Text field [4]. Duplicate or unneeded scripts can also be deleted by selecting the scripts and clicking the Delete button [5].
Within FileMaker Advanced, open the Script Workspace window, select all of the scripts and select Copy from the Edit menu.
Step 3 - Paste FileMaker Scripts From Clipboard Into FmPro Migrator

Click the Add Scripts from Clipboard button to paste the scripts into FmPro Migrator.

You will perform this task for every source database file which contains scripts to be added to the destination database file.

Troubleshooting - Duplicate Script Names

Within a multi-file solution, it is possible to have the same script located within several files. However, duplicate scripts are not allowed within the new single file FileMaker database. When duplicate scripts are pasted into the new consolidated database file, the duplicated scripts will be renamed with an incrementing numeric suffix. There are a couple of options available to solve this situation.

Option #1:
If duplicated scripts are have the same functionality, just delete the duplicated scripts within the FmPro Migrator scripts window.

**Option #2:**
If the duplicated scripts contain different functionality, they should be renamed before copying either the scripts or layouts into FmPro Migrator. One technique could be to add a file referencing prefix to each duplicated script to indicate the source of the script. This will insure that references between the scripts and layout objects will be maintained throughout the migration process.

### Troubleshooting - Missing Scripts with FileMaker Pro Advanced 11

Attempting to copy FileMaker Pro 10 (or earlier) scripts into FileMaker Pro 11 will often cause unexpected results.

For instance the Print Setup step contains either HEX encoded binary data for FileMaker Pro 11, or base64 encoded data for FileMaker Pro 9 - 10.

There are also differences in the XML encoding for single-line scripts, which will prevent the proper parsing of the XML for the current Script Step as well as any following Script Steps or Scripts. Within FileMaker Pro 10 scripts, a single line script will look like this:

```xml
<Script id="37" name="-" includeInMenu="False" runFullAccess="False"/>
```

And in FileMaker Pro Advanced 11 the same script will look like this:

```xml
<Script includeInMenu="True" runFullAccess="False" id="15" name="-"/>
</Script>
```

Therefore it is not recommended that scripts be copied between different versions of FileMaker Pro Advanced when performing the Table Consolidation process.
Step 4
Step 4 - Import Relationships, TOs, Value Lists and Custom Functions

FmPro Migrator imports Relationships, Table Occurrences, Value Lists and Custom Functions by reading the contents of the DDR XML file for each source database file.

Click the Step 4 - Get Relationships button or click on the Relationships tab.
Step 4 - Relationships Tab

The Relationships tab provides an interface for managing the relationships which will be migrated into the consolidated database file.

It won't generally be necessary to make changes on either the Relationships or TOs tab when performing a Table Consolidation project. But changes made on both of these tabs and will be reflected within the destination database file.

Tasks which can be performed on the Relationships tab include:
[1] importing Relationships, TOs, Custom Functions and Value Lists from a DDR XML file,
[2] manually adding one relationship at a time,
[3] generating SQL code to represent a relationship in a SQL database (not used for Table Consolidation projects),
[4] creating relationships within a SQL database (not used for Table Consolidation projects),
[5] creating relationships within a FileMaker Advanced database,
[6] deleting selected relationships,
[7] changing Left Table name,
[8] changing Left Table Cascade Create status,
[9] changing Left Table Cascade Delete status,
[10] changing Right Table name,
[11] changing Right Table Cascade Create status,
[12] changing Right Table Cascade Delete status,
[13] manually changing relationship predicate parameters,
[14] manually adding a relationship predicate,

**Step 4 - Click Import Relationships Button**

Click the Import Relationships button to import relationships from the DDR XML file for the source database file.
Step 4 - Select DDR XML File

The relationships will be imported from the Database Design Report (DDR XML) file and added to the list of relationships on the Relationships tab. TOs, Value Lists and Custom Functions will also be imported from the DDR XML file at the same time, and displayed under the Value Lists and CFs tabs. A dialog will be displayed if there are no Custom Functions or Value Lists found within the DDR XML file.
Step 4 - Remap TOs

It may be necessary to change TOs when performing a Table Consolidation project. Once the Relationships and TOs have been imported, the developer should analyze the usage of these imported objects and review how they were used within the original separate FileMaker database files. For instance, if there were a dozen source database files, and if multiple TOs were created to point to the same base table, then these TOs should probably be renamed in the new consolidated database file.

FmPro Migrator lists the base table and source filenames within the list of TOs, in order to assist the developer with this renaming process. During the Step 5 Remap Objects process, each of these renamed TOs will be automatically renamed to the new values within each Relationship, Layout object and ScriptMaker script.

This screenshot shows a TO named Client which will be renamed to Client_New2.
Clicking on the Value Lists tab displays the Value Lists which were imported from the DDR XML file. Value Lists shown with a type of Custom, are static value lists having a manually edited list of values (as shown in this screenshot). Value Lists displayed with a type of Field, are dynamically generated value lists which get their value from a field within the database. Static value list items can be manually edited by clicking on the Value List and changing the values. Changes are saved automatically when clicking out of the Static Value List field.

**Troubleshooting - Duplicate Value List Names**

Within a multi-file solution, it is possible to have the same value list located within several files. FmPro Migrator will automatically filter out duplicated value lists when building them in the new consolidated file. There are a couple of options available to solve this situation.

**Option #1:**
If duplicated value lists contain the same values, just delete the duplicated value lists within the
FmPro Migrator Value Lists window.

**Option #2:**
If the duplicated value lists contain different values, they should be renamed before copying either the value lists or layouts into FmPro Migrator. One technique could be to add a file referencing prefix to each duplicated value list to indicate the source of the value list. This will insure that references between the value list and layout objects will be maintained throughout the migration process.

**Step 4 - Custom Function - Details**

Clicking on the CFs tab displays the Custom Functions which were imported from the DDR XML file. Custom Functions and their parameter lists are displayed. The Custom Function Code can be manually edited by clicking on the Custom Function and changing contents of the Custom Function Code field. Changes are saved automatically when
clicking out of the Custom Function Code field.

If the Custom Function code is edited in FmPro Migrator and results in an error when it is being saved in FileMaker, batch processing will be interrupted.

**Note:** If the Custom Function code is manually edited, these changes won't be reflected in the Custom Function pasted via the clipboard into FileMaker 15+ versions using the clipboard icon at the top of the CFs tab.
Step 5
Click the Step 5 - Remap Objects button to remap changed TOs within all Relationships, Layout objects and Scripts. Layout text Search & Replace tasks will also be performed.

External filename dependencies are removed from within each Script because all of the Scripts will now run from the new destination file where all of the tables are being consolidated.

Note: The FileMakerDB.fp7 file should not be open within FileMaker Advanced when clicking this button, as FmPro Migrator will be attempting to open this file automatically at the end of the Step 5 Script processing.
Step 6
Step 6 - Create Tables, TOs and Relationships

Close any source database files which might still be open from previous steps.

If necessary, open the FileMakerDB.fp7/FileMakerDB.fmp12 file within the output directory using FileMaker Advanced. This file was created and should have been opened automatically by FmPro Migrator during Step 5.

This file has been customized for Table Consolidation projects with the addition of scripts/layouts and a placeholder TO required during the migration process.

If you want to use your own existing file as the destination file, then copy these objects into your database file:
1) Copy the table named "= Placeholder TO".
2) Copy the ScriptMaker scripts [used on Windows only].
3) Copy the "Get TOs List" layout [used on Windows only].
4) Make sure that there aren't any TOs within your database file starting with the "=" character. This placeholder TO is used by the WinAutomation scripts while creating Relationships, in order to make sure that the correct TO is being selected from TO menu lists. Each time a TO is selected from a TO list, the "=" character is sent to initialize FileMaker to this specific placeholder TO in the list before sending the characters of the TO name.
5) Make sure that the Save Layout Changes Automatically option is checked on the Layouts tab of FileMaker preferences for the file. The automated scripts which create the layouts are not designed to click on the Ok dialog to save layout changes for each layout as it is being created.

Step 6 - Create Tables - Copy Tables to Clipboard

Click the Copy All Tables to Clipboard button on the Tables tab.

All of the source tables will be put onto the Clipboard, ready for pasting into FileMaker Advanced.
Step 6 - Create Tables - Paste Tables From Clipboard

Select Manage Database from the File menu within FileMaker Advanced. Note: The Manage Database window will be automatically opened and the Tables tab will be selected via AppleScript on macOS.

Click the Paste button.

**Note:** If the Paste button is grayed out, this means that the table XML code didn't get copied to the Clipboard before the Manage Database dialog was opened. If this happens, click the Copy All Tables to Clipboard button again from within FmPro Migrator.
Step 6 - Create Tables - Paste Tables From Clipboard

The tables will be pasted from the Clipboard, and displayed in the Define/Manage Database window.

**Note:** After pasting these tables, you will need to delete the extra layouts which were automatically created by FileMaker Pro Advanced. These extra layouts must be deleted so that FmPro Migrator knows exactly how many layouts exist in the file when it copies the migrated layouts into the file.

Manual Task - Create External Data Sources

**Note:** If your database contains external data sources, these will need to be manually re-created prior to creating TOs, Relationships, Layouts or Scripts.
Create these External Data Sources before proceeding to the following steps.
Click the TOs tab.

Click the Create All TOs in FileMaker button, to build the non-Base Table TOs within the destination FileMaker database file.

The RelationshipGraph window will be opened within FileMaker, and each of the TOs will be created.

It is not generally necessary for you to click any of these buttons in the status area. These buttons
perform the following tasks:

**Next TO** - This button gets clicked internally by FmPro Migrator after creating each TO, in order to start the process of creating the next TO.

**Done** - Click this button if you want to cancel the TO creation process.

**Note**: The AppleScript code runs so quickly that it is unlikely that you will have a chance to manually click any of these buttons.

---

**Step 6 - Create TOs - [Windows Status Area]**

![Image of status area with buttons: Next TO, Current TO, Done.]

The RelationshipGraph window will be opened within FileMaker, and each of the TOs will be created.

It is not generally necessary for you to click any of these buttons in the status area. These buttons perform the following tasks:

**Next TO** - This button gets clicked internally by FmPro Migrator after it creates each TO, in order to start the process of creating the next TO.

**Done** - Click this button if you want to cancel the TO creation process.
Step 6 - Create Relationships

Click the Relationships tab.

Click the Create All Relationships in FileMaker button.

**Relationship creation batches:**
FmPro Migrator loops thru the relationships in groups of 100 when creating the relationships. Once it has reached every 100th relationship, the Ok button is clicked in order to save that group of relationships. The relationship graph is opened again and the processing continues for the next 100 relationships. This process continues until all of the relationships have been created. This processing technique is used in order to prevent FileMaker Pro Advanced from running out of memory. Under normal operating conditions with a user creating relationships, it is not likely that a lot of relationships would be created before the user saves the changes. But when automating the process, there could be hundreds or even thousands of relationships which might need to be created.
Step 6 - Create Relationships - [ macOS Status Area]

The Relationships window will be opened within FileMaker, and each of the Relationships will be created.

It is not generally necessary for you to click any of the buttons in the status area. These buttons perform the following tasks:

**Next Relationship** - This button gets clicked internally by FmPro Migrator after it creates each Relationship, in order to start the process of creating the next Relationship.

**Done** - Click this button if you want to cancel the Relationship creation process.

**Note:** The AppleScript code runs so quickly that it is unlikely that you will have a chance to manually click any of these buttons.

**Note:** The value listed as the total number of relationships actually represents the total number of relationship predicates which are being processed.

Step 6 - Create Relationships - [ Windows Status Area]

It is not generally necessary for you to click any of the buttons in the status area. These buttons perform the following tasks:

**Next Relationship** - This button gets clicked internally by FmPro Migrator after it creates each Relationship, in order to start the process of creating the next Relationship.

**Done** - Click this button if you want to cancel the Relationship creation process.

**Note:** The value listed as the total number of relationships actually represents the total number of relationship predicates which are being processed.
Step 6 - Review Created TOs and Relationships

After creating all of the TOs and Relationships, it is recommended that the new Relationships and TOs be reviewed on the RelationshipGraph window. When reviewing the relationships, consider whether any new TOs were created. When the FileMaker Pro Advanced database creates Relationships, extra TOs are created in situations which would result in more than 1 set of links to a single TO.

When converting a multi-file solution into a single file solution, check to see if are any existing relationships which will be duplicated within the new consolidated database file. Having the same relationship duplicated multiple times, will result in additional TOs created having the same name as the original TO, but also having an incrementing number appended to the TO. These additional relationships can be made to work in the new file, but would likely require manually pointing fields and portals on Layouts to a different TO on the RelationshipGraph - thus requiring extra unnecessary work at the end of the conversion process.

Therefore duplicated or unused relationships should be deleted from the Relationships tab within FmPro Migrator. At this point in the process, the unneeded relationships could be deleted from the Relationships tab within FmPro Migrator and then all of the relationships could be re-created using the Step 6 instructions.

Note: It will be necessary to manually delete any relationships or non-base table TOs which were automatically created on the RelationshipGraph within FileMaker Pro Advanced. If there are many items which need to be deleted, it may be easier to delete all objects on the RelationshipGraph, then delete and re-paste the Table XML definitions via the Clipboard.

Deleting of TOs within FmPro Migrator is not recommended, because they should simply be remapped to the correct TO in the new consolidated file. If this type of change is required at this point in the process, press the Step 5 button again to remap TOs after making any changes to the New TO Name fields.
Click the Step 6 button to start the process of creating Custom Functions in the new consolidated database file. Custom Functions should be created before pasting the tables into the new consolidated database file in case the Custom Functions are used within the definition of Calculation field definitions.
Skip this step if there are no Custom Functions within your database files.
**Step 6 - Create Custom Functions**

1) Use FileMaker Advanced to open the new empty FileMaker file within the output directory.

2) Click the Create All Custom Functions in FileMaker button on the CFs tab.

3) Click the Copy All Tables to Clipboard button (at the top of this screen), then paste these Base Table definitions into the Manage/Define -> Database -> Tables window within FileMaker Advanced.

4) Click the Create TOs in FileMaker button on the TOs Tab.

Click the Ok button on the information dialog.
Click the CFs folder tab.
Step 6 - FileMaker 15+ Copy Custom Functions to Clipboard

FileMaker Pro Advanced 15+ versions allow copying and pasting of Custom Functions via the clipboard. Click the Copy all Custom Functions to Clipboard button on the CFs tab of the Migration Process window to use this feature.

On macOS and Windows - FmPro Migrator will automatically open the Mangae Custom Functions window, put the Custom Functions XML code onto the clipboard, then it will trigger FileMaker to...
Paste the clipboard contents. The Custom Functions will get pasted automatically and show up in the list of Custom Functions listed in the Manage Custom Functions window. Any duplicated Custom Functions will be re-named automatically with an incrementing number following the name.

**Step 6 - Create Custom Functions [FileMaker 11 - 14 Only]**

![Custom Functions list in FileMaker](image)

**Note**: This procedure is obsolete with FileMaker 15+ versions, and is only used for FileMaker 11, 12, 13, 14 versions.

Click the Create All Custom Functions button.
Step 6 - Create Custom Functions - [macOS Status Area]

The Define/Manage Custom Functions window will be opened within FileMaker, and each of the Custom Functions will be created.

It is generally not necessary to click any of the buttons in the status area. These buttons perform the following tasks:

Next CF - This button gets clicked internally by FmPro Migrator after it creates each Custom Function, in order to start the process of creating the next Custom Function.

Done - Click this button if you want to cancel the Custom Function creation process.

Note: The AppleScript code runs so quickly that it is unlikely that you will have a chance to manually click any of these buttons.

Step 6 - Create Custom Functions - [Windows Status Area]

The Define/Manage Custom Functions window will be opened within FileMaker, and each of the Custom Functions will be created.

It is generally not necessary to click any of the buttons in the status area. These buttons perform the following tasks:

Next CF - This button gets clicked internally by FmPro Migrator after it creates each Custom Function, in order to start the process of creating the next Custom Function.

Done - Click this button if you want to cancel the Custom Function creation process.
Step 7
Step 7 - Create Value Lists

Click the Step 7 button to start the process of creating Value Lists in the new consolidated database file. Value Lists should be created before creating Layouts within the new consolidated database file in order to resolve dependencies between Layout objects and Value Lists which need to exist before creating the Layout objects.
Skip this step if there are no Value Lists within your database files.
Step 7 - Create Value Lists

1) Click the Create All Value Lists in FileMaker button on the Value Lists tab.

2) On the Layouts Tab, click the Copy All Layouts to FileMaker button to re-create all the layouts within FileMaker.

3) On the Scripts Tab, Click the Copy All Scripts onto Clipboard button, paste these scripts into the ScriptMaker window within FileMaker.

4) On the Layouts Tab, select Pass#2 from the pop-up menu, then click the Copy All Layouts to FileMaker button again to re-create all the layouts within FileMaker.

Click the Ok button on the information dialog.
After the Ok button has been clicked, the Value Lists screen will be displayed.
Step 7 - FileMaker 16 Copy Value Lists to Clipboard

FileMaker Pro Advanced 16 adds a new feature enabling the copy & paste of Value Lists via the clipboard. FmPro Migrator supports this new feature with a new button on the Value Lists tab. Click the Copy All Value Lists to Clipboard button.
Step 7 - FileMaker 16 Paste Value Lists into Manage Value Lists Window

FmPro Migrator will:
1) Put the Value Lists data onto the clipboard in the correct format for FileMaker to read.
2) Open the Manage Value Lists window.
3) Automatically enter Command-V (macOS) or Control-V (Windows) which instantly pastes the Value Lists into the Manage Value Lists window.

Notice in this screenshot, that all Custom and Field based Value Lists have been created automatically.

From here, you may Click the Ok button to save the new Value Lists, make changes or click the Cancel button.
Step 7 - FileMaker 16 Create Value Lists

When using FileMaker 16, if you click the "Create All Value Lists in FileMaker" button, you will be prompted to use the new "Copy All Value Lists to Clipboard" button.

Step 7 - FileMaker 11 - 15 - Create Value Lists - Click Create All Value Lists Button

Click the Create All Value Lists button.
Step 7 - Create Value Lists - [Mac OS X Status Area]

The Manage Value Lists window will be opened within FileMaker Pro Advanced, and each of the Value Lists will be created.

It is generally not necessary to click any of the buttons in the status area. These buttons perform the following tasks:

Next VL - This button gets clicked internally by FmPro Migrator after it creates each Value List, in order to start the process of creating the next Value List.

Done - Click this button if you want to cancel the Value List creation process.

Note: The AppleScript code runs so quickly that it is unlikely that you will have a chance to manually click any of these buttons.

Step 7 - Create Value Lists - [Windows Status Area]

The Manage Value Lists window will be opened within FileMaker Pro Advanced, and each of the Value Lists will be created.

It is generally not necessary to click any of the buttons in the status area. These buttons perform the following tasks:

Next VL - This button gets clicked internally by FmPro Migrator after it creates each Value List, in order to start the process of creating the next Value List.

Done - Click this button if you want to cancel the Value List creation process.
Step 7 - Create Scripts and Layouts

**Step 7 - Automatically Save Layout Changes Preference (macOS) - [1st Time Setup Step]**

Select the FileMaker Preferences menu item, (1) click the Layouts tab, (2) click the checkbox to enable the "Save layout changes automatically (do not ask)" option, then (3) click the OK button.
One of the important tasks listed in the WinAutomation Installation PDF file is to set the "Save layout changes automatically" option within the FileMaker Advanced Preferences dialog. Select the FileMaker Preferences menu item, (1) click the Layouts tab, (2) click the checkbox to enable the "Save layout changes automatically (do not ask)" option, then (3) click the OK button.
Click on the Layouts tab.

Scripts and Layouts are processed in the following manner:
1) Copy all of the Layouts from FmPro Migrator into the destination FileMaker database, with the Pass#1 pop-up menu selected.
2) Copy the Scripts from FmPro Migrator and paste into the ScriptMaker window within the destination FileMaker database.
3) Re-create each of the layouts again within the FileMaker destination database, with the Pass#2 pop-up menu selected. This 2nd pass resolves issues with circular dependencies between Layouts and Scripts.
On the Layouts tab, click the Create All Layouts in FileMaker button. The Pass#1 pop-up menu should be selected under the Create All Layouts in FileMaker button.

**Step 7 - Create Layouts - Click Layout Canvas**

On macOS and Windows, a dialog is presented requesting a click to be made to the upper left corner of the layout canvas. Clicking as close as possible to the upper left corner of the layout causes FileMaker to paste the layout contents starting at this location. If for instance you clicked at
position 100, 100, then the contents of the layout would be placed 100 pixels down from the top and 100 pixels over from the left edge of the layout [and you generally would not want the contents to be offset this way].

**Step 7 - Create Layouts - [ Mac OS X Status Area]**

The data window will be opened in Layout mode within FileMaker, and each of the Layouts will be created from the information stored within FmPro Migrator.

It is not generally necessary for you to click any of the buttons in the status area. These buttons perform the following tasks:

**Next Layout #1** - This button gets clicked internally by FmPro Migrator after it creates each Layout, in order to start the process of creating the next Layout.

**Done #1** - Click this button if you want to cancel the Layout creation process.

**Note**: The AppleScript code runs so quickly that it is unlikely that you will have a chance to manually click any of these buttons.

**Step 7 - Create Layouts - [ Windows Status Area]**

It is not generally necessary for you to click any of the buttons in the status area. These buttons perform the following tasks:

**Next Layout** - This button gets clicked internally by FmPro Migrator after it creates each Layout, in order to start the process of creating the next Layout.

**Done** - Click this button if you want to cancel the Layout creation process.
Use the [1] Create All Scripts in FileMaker batch processing button to create each script one at a time in batch processing mode (macOS only).
This technique seems to work more reliably to create the scripts in FileMaker, because sometimes scripts get missed when copying all of them onto the clipboard at once. The scripts should still be examined in order to insure that the entire script got copied.

On Windows, use the [2] Copy All Scripts to Clipboard button, to put all of the scripts onto the clipboard at once, for pasting into FileMaker.
Step 7 - Create Scripts - Paste Scripts From Clipboard into FileMaker [Windows]

Open the Script Workspace window, select Paste from the Edit menu.

All of the consolidated and remapped scripts from FmPro Migrator will be pasted into the destination FileMaker database.

At this point in the process, there are no more unresolved dependencies between scripts and layouts because the layouts have all been created. But there are unresolved dependencies between layout objects and scripts, which will be resolved when the layouts are recreated in Pass#2.

Step 7 - Create Layouts - Select Pass#2 Menu

Selecting the Pass#2 menu instructs FmPro Migrator to replace the contents of existing layouts instead of creating new layouts within the FileMaker database.
Each of the layouts has already been created within the FileMaker database. During the 2nd Pass, the contents of each layout will be deleted and replaced, but the actual layout itself will not be deleted. This process resolves dependencies between layouts and scripts without adversely affecting the dependencies between scripts and layouts.

Note: It is important to not add, remove or rearrange layouts between the Pass#1 and Pass#2 processing. FmPro Migrator is expecting a there to be exactly 1 more layout than the number of layouts listed in the layouts field, and is expecting each of the layouts to be displayed in the same order as they are listed (alphabetically) within the layouts list field. FmPro Migrator will automatically skip past the first layout named "Get TOs List" and start replacing layout contents with the 2nd layout in the database.
Step 8
At this point in the Table Consolidation process, all of the database objects have been created within the consolidated database file. But the data is still stored within the individual source database files. Step 8 processing generates table import scripts for each base table within the consolidated database file.

Click the Step 8 button on the Tables tab of FmPro Migrator.
Step 8 - Click Ok to Creation Dialog

1) The FileMaker data import scripts have been created and are now on the clipboard.

2) Paste these scripts into the Script Workspace, then run the script named '_Import All Tables'. This script will import all data from each individual file into the new tables within the consolidated file.

Step 8 - Paste Scripts into FileMaker

The import scripts have been generated and put onto the ClipBoard.

Open the FileMaker Script Workspace window, and select Paste from the Edit menu.

If the Paste option is not available for selecting, close and re-open the Script Workspace window.
Step 8 - Using the Import Scripts

The import scripts are created using the following design criteria:

1) Each source file contains only one table and the filename is *Tablename.fp7/Tablename.fmp12*.  
2) Each base table has a corresponding layout in the destination database. FmPro Migrator will find the first layout using the required base table and will generate the script with this layout name.  
   **Note**: This will almost always be the case with migrated files. Sometimes (rarely) it may be necessary to select an appropriate layout to use for the Goto Layout statement at the start of each import script.  
3) Each of the source files are located within the same folder as the destination file. 
Since modifications may be required to the import scripts, it is recommended that they be run one at a time the first time they are run, for testing purposes. Executing the _Import All Tables script will conveniently run all of the scripts and import data into all of the tables.
Finishing Up
Manual Completion Tasks

Some tasks can't be completed automatically within a FileMaker database, and require manual intervention.

1) Field lookup settings for table fields need to be manually re-entered for any fields which are configured with lookups. This is due to the fact that the relationships did not exist at the time when the tables were pasted into the Manage Database dialog.

2) Objects on the RelationshipGraph can't be moved automatically to create an easy to read display. It is often helpful to move and colorize TOs according to how they are being used within a solution. This task can only be done manually.

3) Layout Header, Body, Footer locations cannot be automatically specified during Layout creation. The positions of these Layout parts are not stored within the DDR XML file or the Layout XML code placed onto the ClipBoard. Therefore these Layout parts need to be moved into position manually. When FmPro Migrator creates each layout during Pass#1 processing, the Header and Footer layout parts are automatically deleted from the layout. This is done in order to make it easier for the developer to manually add the necessary layout parts. It is quicker to add a new layout part than it is to resize, move or delete existing layout parts which already contain layout objects.

4) Layout print settings including number of columns, print order, and script triggers assigned to a layout also need to manually set for each layout.

5) Layout form/list/table view settings need to be manually set up for each layout since this info is not placed onto the clipboard by FileMaker. By default, FmPro Migrator will create each layout to be displayed in Form view mode.

6) Dynamic value lists are created during Step 6 of the table consolidation process. These dynamic value list names are placeholders which require the developer to manually select the field display options. The XML defining the value list is pasted into the Custom Values window. This info could provide a helpful reference to the definition of the value list, but it would still be easier to look at the value list in the source database file.

**Note**: Field based Value Lists are created automatically by FmPro Migrator for FileMaker 16+ versions.

7) Review the Relationships and TOs which were created in Step 6 to verify whether the originally
defined TOs should be used within each Layout object, portal and script. New TOs may have been created by FileMaker Pro Advanced during the automated relationship creation process. New TOs could have been created unnecessarily if there were duplicate copies of relationships imported from each individual file. It will typically be quicker to delete these duplicate relationships and re-do Steps 6, 7 and 8 using a new empty file rather than try to repoint each field, portal and script step to the correct TO.

**Note:** To get FmPro Migrator to create a new empty FileMakerDB.fp7/FileMakerDB.fmp12 file, close and rename the existing file, select the File -> Export FileMaker Template Database menu item and a new empty FileMakerDB.fp7/FileMakerDB.fmp12 file will be created within the output directory.

8) Testing. Each Script, button and Layout should be tested to verify correct operation. Since the testing process could take some time, it can be useful to use the _Import All Tables script to reimport the data from the live solution once development and testing has been completed. To make an empty file for re-importing purposes, you can simply select Save A Copy As... [clone - no records] from the File menu.
Troubleshooting AppleScript GUI Automation [macOS]

FmPro Migrator uses embedded AppleScript code to automate importing Layouts, and building Custom Functions, Value Lists, Table Occurrences, Relationships, Scripts and Layouts in FileMaker database files. Detailed info about this AppleScript code is included in this section of the manual.

Troubleshooting - Locks Up with No Processing Completed [macOS]

If a batch processing task starts, but appears to lock up with no activity, then force quit and re-launch FmPro Migrator from the Finder and open the Status Window by selecting the File -> Status Window menu item. Click the batch processing button again, and review the results in the Status Window.

FmPro Migrator will continue to log the results of its AppleScript processing handlers in the Status Window as long as the window is open.

As shown above, the ASwitchFMToLayoutMode handler has run, but nothing else has completed. This type of problem can be due to having 2 copies of FileMaker Pro Advanced open at the same time. Some of the commands might get sent to one copy of FileMaker and other commands could get sent to the 2nd copy of FileMaker.

If a single copy of FileMaker Pro Advanced is running, but the FileMakerDB.fp7/FileMakerDB.fmp12 file is not open, a similar problem might also occur. Generally, FmPro Migrator should detect these types of situations and warn you automatically at the start of automated process.

Troubleshooting - List of AppleScript Handlers

FmPro Migrator uses the following handlers containing dynamically compiled AppleScript code:

**ASCHECKFMVERSION** - check the currently running FileMaker version to make sure it matches the selected version

**ASCHECKGUIscriptingMODE** - Checks to determine if GUI Scripting is enabled for use by AppleScript. If false, it will issue the command to enable macOS Accessibility features on macOS 10.8 or below. For macOS 10.9, the user will be prompted to open System Preferences to enable Accessibility for FmPro Migrator.
AScloseFMCustomFunctionsWindow - Closes the “Manage Custom Functions...” window by clicking the Ok button.

AScloseFMManageScriptsWindow - Closes the “Manage Scripts...” window by clicking on the close button, selects first script in list in preparation for creating the next script.

AScloseFMRelationshipGraphWindow - Sends a return keystroke to close the FileMaker Relationship Graph window.

AScloseFMValueListsWindow - Closes the “Manage Value Lists...” window by clicking the Ok button.

AScopyFMLayout - Copies the current FileMaker layout into FmPro Migrator.

AScopyLayout2FM - Creates a new empty layout in FileMaker (Pass #1), sets layout name, sets TO Name for new layout, deletes layout header, footer parts, pastes the layout XML already on the clipboard, clicks Yes to extend objects dialog #1, #2.

AScreateFMCustomFunction - Reads Custom Function creation parameters from the Clipboard. Creates a new FileMaker Custom Function, having the proper name, parameters and code, then saves it.

AScreateFMCustomValueList - Creates a FileMaker custom value list and saves it. Field based value lists are also created, but the properties need to be set manually.

AScreateFMRelationship - Reads relationship creation parameters from the Clipboard, storing info in 10 variables, creates a new relationship or a predicate for an existing relationship which is already being worked on.

AScreateFMTO - Gets the TOName and Base Table Name from the Clipboard then creates a new FileMaker TO. Note: Setting the TO color is not supported.

ASdeleteFMLayoutParts (function) - Deletes the Header and Footer layout parts from a new empty layout, leaving the Body part.

ASgetTOListPosition (function) - Returns the position number of a TO name within a list of TOs. The returned value is used for selecting a specific line (TO name) within a popup menu. This needs to be done with a numeric index to the TO name instead of passing in the actual TO name via keystrokes.

ASglobalsAndHandlers (function) - returns the AppleScript code having the global variables and commonly used handlers
ASgotoNextFMLayout (function) - Advances to the next FileMaker layout while in layout mode, by sending the control down arrow keystroke.

ASopenFMCustomFunctionsWindow - Opens the “Manage Custom Functions” window using the File menu.

ASopenFMEditRelationshipWindow - Opens Edit Relationship window using command shift r keystroke, waits for window to open.

ASopenFMManageScriptsWindow - Opens the “Manage Scripts...” window using the Command Shift S keystroke.

ASopenFMManageTablesWindow - Opens “Manage Database” window, clicks on the Tables tab.

ASopenFMRelationshipGraphWindow - Opens “Manage Database” window, clicks on the Relationship Graph tab. NOTE: Doesn't work with 8,9,10 because window doesn't refresh when Relationship Graph tab is clicked.

ASopenFMValueListsWindow - Opens the “Manage Value Lists...” window using the File menu.

ASpasteFMScript - Clicks the first row of the scripts displayed in the “Manage Scripts...” window. Pastes the current script XML on the clipboard using Command V keys.

ASreplaceLayout2FMPass2 - Selects the contents of the current layout in Layout mode, deletes the contents, pastes the layout contents already on the clipboard. Used during Pass #2 processing during Table Consolidation projects.

ASsaveFMRelationship - Sends keystroke return key to click the Ok button of the Edit Relationship window to save the current relationship.

ASsaveFMRelationship (function) - Sends return key keystroke to click the Ok button of the Edit Relationship window to save the current relationship. Sends another return key keystroke if the Rename TO dialog is displayed.

ASswitchFMToBrowseMode - Switches to Browse Mode using Command b keys.

ASswitchFMToLayoutMode - Switches to Layout Mode, using Command L keys, advances to layout #1.
Export AppleScript Code

On MacOS X, the AppleScript code is embedded within FmPro Migrator therefore no installation is required.

It may be helpful to review the AppleScript source code for troubleshooting purposes, therefore it can be exported to the output directory by selecting the File -> Export AppleScript or WinAutomation Scripts menu.

Selecting this menu will save a text file of AppleScript code, a LiveCode AppleScript test stack and a LiveCode performance testing stack to the output directory.
These files have been released as open source for use by the FileMaker community.
The AppleScript code embedded within FmPro Migrator follows the naming strategy used within the FmPro Migrator AppleScript Utility???.applescript text file.
Many of the AppleScript handlers embedded within FmPro Migrator have been converted into LiveCode handlers within the FmPro Migrator AppleScript Embedded Tester stack file. This stack file serves as a test harness for testing the embedded AppleScript code, prior to implementing it within FmPro Migrator. This stack is also released as open source software.

Download a copy of LiveCode from the [www.livecode.com](http://www.livecode.com) website to open this stack file.

Right click the mouse on any of the buttons to see the code which is being called.

Select the LiveCode Object -> Stack Script menu item to see the stack level handlers.
Troubleshooting WinAutomation GUI Automation [Windows]

FmPro Migrator includes a compiled WinAutomation job to provide GUI automation, at no cost. FmPro Migrator automatically writes this executable job file into a new WinAutomation_Jobs folder within the user's Documents directory, and then executes this file as needed. Note: Starting with WinAutomation v6, these Jobs are now called Robots, and the icons in the windows look a little different compared to previous versions - but the functionality remains the same.

**FileMaker Versions Supported - FM11, FM15+**

On Windows, the WinAutomation jobs/robots are currently supported and tested with FileMaker Pro Advanced 11 and FileMaker Pro Advanced 15+.

**Windows OS - Must be set to use English**

The WinAutomation Job/Robot actions always look for the English text of the controls & windows being used within FileMaker Pro Advanced. For this reason, the English language needs to be used for the Windows operating system.
Windows 10 User Account Control Settings

Choose when to be notified about changes to your computer

User Account Control helps prevent potentially harmful programs from making changes to your computer.
[Tell me more about User Account Control settings]

Always notify

Never notify me when:

- Apps try to install software or make changes to my computer
- I make changes to Windows settings

Not recommended.

Windows 10 sometimes seems to be overly enthusiastic about notifying the user whenever an app is launched. It may sometimes be necessary to temporarily disable this feature during GUI automation tasks. FmPro Migrator runs the compiled WinAutomation Job/Robot file many times automatically during processing - and you don't want the EXE to be blocked waiting for the user to click to allow it to run every time.

Most of the time, this setting doesn't cause any problems, but if it does cause a problem it can be changed in the Control Panel:

This setting is found in: Control Panel -> Security & Maintenance -> User Account Control Settings.
Maximized Window Problem

In order for the compiled WinAutomation job to find menu items within the FileMaker user interface, the database window should not be maximized. If the window has been maximized, click the restore down button to solve this problem.

WinAutomation Notification Window

The compiled WinAutomation job (or robot) file has been developed with notifications enabled to allow troubleshooting during the processing. In this screenshot:

_FmPro Migrator WA Jobs - Is the name of the compiled job file.

switchFMTToLayoutMode - Is the name of the function within the job file which is currently running.

action #8 - Is the number of the action being executed within this particular function.

( Press Button in Window ) - This is the name of the action being executed. In this example, pressing the OK button on the Specify Number window to goto layout #1.

WinAutomation - Wrong Job Executing

If you notice that the wrong jobs are executing, then it may be necessary to perform the following steps. This might occur if a job action fails during processing. There could also be multiple copies of the _WinAutomation_Jobs.exe application running.

1) Exit the FmPro Migrator application.
2) Delete the Parameters.txt and Clipboard.txt files from within the C:\My Documents\WinAutomation_Jobs folder.
3) Restart Windows.

### Localization

The Actions in the compiled WinAutomation job file have been developed using the English version of FileMaker Pro Advanced. The WinAutomation Actions could be changed to support a different language. This change would need to be made for each button, window name reference and field specified within the functions of the job file.

The source code for the job file is written into the C\<username>\My Documents\WinAutomation_Jobs folder as a file named _FmPro Migrator WA Jobs.waj. This file is available under open source licensing, and modifications can be made by the user if necessary, for instance for updating the job file to work with localized versions of FileMaker.

After making changes in the WinAutomation Job Designer, save the changes, recompile and save the compiled job into the WinAutomation_Jobs folder using WinAutomation Professional. **WinAutomation Professional** is required in order to compile WinAutomation jobs into executable files.

### WinAutomation Function Names

- **closeFMCustomFunctionsWindow** - Closes the “Manage Custom Functions...” window by clicking the Ok button.

- **closeFMScriptsWindow** - Closes the “Manage Scripts...” window by clicking on the close button, selects first script in list in preparation for creating the next script.

- **closeFMRelationshipGraphWindow** - Closes the FileMaker Relationship Graph window by
clicking the Ok button.

**closeFMValueListsWindow** - Closes the “Manage Value Lists...” window by clicking the Ok button.

**copyFMLayout** - Copies the current FileMaker layout into FmPro Migrator.

**copyLayout2FM** - Creates a new empty layout in FileMaker (Pass #1), sets layout name, sets TO Name for new layout, deletes layout header, footer parts, pastes the layout XML already on the clipboard, clicks Yes to extend objects dialog #1, #2.

**createFMCustomFunction** - Reads Custom Function creation parameters from the Clipboard. Creates a new FileMaker Custom Function, having the proper name, parameters and code, then saves it.

**createFMCustomValueList** - Creates a FileMaker custom value list and saves it. Field based value lists are also created, but the properties need to be set manually.

**createFMRelationship** - Reads relationship creation parameters from the Clipboard, storing info in 10 variables, creates a new relationship or a predicate for an existing relationship which is already being worked on.

**createFMTO** - Gets the TOName and Base Table Name from the Clipboard then creates a new FileMaker TO. Note: Setting the TO color is not supported.

**deleteFMLayoutParts** - Deletes the Header and Footer layout parts from a new empty layout, leaving the Body part.

**getTOListPosition** - Returns the position number of a TO name within a list of TOs. The returned value is used for selecting a specific line (TO name) within a popup menu. This is done with a numeric index to the TO name instead of passing in the actual TO name via keystrokes.

**gotoNextFMLayout** - Advances to the next FileMaker layout while in layout mode, by sending the control down arrow keystroke.

**openFMCustomFunctionsWindow** - Opens the “Manage Custom Functions” window using the File menu.

**openFMEditRelationshipWindow** - Opens Edit Relationship window by clicking the Add Relationship button, waits for window to open.

**openFMMCreateValueListWindow** - Opens the “Manage Scripts...” window using the Control Shift S keystroke.
openFMManageTablesWindow - Opens "Manage Database" window, clicks on the Tables tab.

openFMRelationshipGraphWindow - Opens "Manage Database" window, clicks on the Relationship Graph tab.

openFMValueListsWindow - Opens the “Manage Value Lists...” window using the File menu.

pasteFMScript - Clicks the first row of the scripts displayed in the “Manage Scripts...” window. Pastes the current script XML on the clipboard using Control V keys.

replaceLayout2FMPPass2 - Selects the contents of the current layout in Layout mode, deletes the contents, pastes the layout contents already on the clipboard. Used during Pass #2 processing during Table Consolidation projects.

saveFMRelationship - Clicks the Ok button of the Edit Relationship window to save the current relationship. If the rename TO dialog is displayed, clicks the Ok button to that dialog also.

switchFMToBrowseMode - Switches to Browse Mode using Control B keys.

switchFMToLayoutMode - Switches to Layout Mode, using Control L keys, advances to layout #1.

Troubleshooting WinAutomation Jobs within WinAutomation

The _FmPro Migrator WA Jobs.waj file contains the source code for the automation job. Import this file into the WinAutomation Console to test, update or debug the jobs.

To run the jobs within the WinAutomation Console, first run the job using the FmPro Migrator WinAutomation Tester stack (documented in a separate chapter of this PDF), in order to setup the Parameters.txt file and the Clipboard.txt file.

Then click the Run button in the Job Designer. Breakpoints can be set as needed and variables can be inspected during debugging.
About the FmPro Migrator WinAutomation Tester [Windows]

The FmPro Migrator WinAutomation Tester is a LiveCode 7+ stack file used to test WinAutomation jobs [now called Robots] used to automate tasks within a FileMaker Pro Advanced 11 - 16 database.

LiveCode is a dual licensed, cross platform development environment. A free copy of LiveCode Community Edition can be downloaded from the LiveCode.com website.

v 4
3/28/2017
Added support for FileMaker Pro Advanced 16, and changed the version numbering of the tester to match the actual _FmPro Migrator WA Jobs.exe version.

Architecture

![Architecture Diagram]

Process Flow:

1) The FmPro Migrator WinAutomation Tester stack writes the Parameters.txt file and an optional Clipboard.txt file into the WinAutomation_Jobs directory and the Completed.txt file is deleted.

2) The FmPro Migrator WinAutomation Tester stack executes the compiled WinAutomation jobs application file (_FmPro Migrator WA Jobs.exe), and then enters a loop, waiting for completion of the job.
3) As soon as the WinAutomation jobs application runs, it opens the Parameters.txt file in order to determine which function to run.

4) Once the requested function has been completed, the Completed.txt file is written by the WinAutomation jobs application, and the application exits.

5) The FmPro Migrator WinAutomation Tester stack exits the infinite loop based upon finding the existence of the Completed.txt file, and returns control back to the user.
Clicking the Check WA Jobs button creates the WinAutomation_Jobs folder within the Documents directory. The _FmPro Migrator WA Jobs.exe and _FmPro Migrator WA Jobs.waj binary files are written into the the WinAutomation_Jobs folder. The Version.txt file is also written.

This task only needs to be done once.
Verifying FileMaker Pro Advanced Version

Launch the FileMaker Pro Advanced application. The FileMaker Pro Advanced application needs to already be running in order for any of these tasks to complete.

However it is important to verify that the correct version of FileMaker is running before running the automation jobs.

1) Select the version of the currently running FileMaker Pro Advanced application from the FM Version menu.
2) Click the Test FM Version button. If the versions match, then no error message will be displayed. Otherwise an error dialog is displayed.

Running Automation Tasks

One of the simplest tasks to test is switching between Browse and Layout modes. These tasks require no setup prior to running.

Tasks like Copy Layout 2FM, Replace Layout 2FM Pass#2 - require that a FileMaker layout already be copied onto the clipboard when the button is clicked.

The Goto Next Layout task, requires that FileMaker be in Layout mode.
Tooltips are provided for task buttons which require a layout or script to be on the clipboard before running.

**Troubleshooting the Compiled WinAutomation Application**

![Error message dialog]

The compiled WinAutomation Jobs file is compiled with the option to display Notifications and Error Message Dialogs, for troubleshooting purposes. This error in the `switchFMToLayoutMode` function is due to FileMaker Pro Advanced not being found running at the time the job is running.